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i Welcome to Synapse

Welcome to SMART

SMART (System for Manuscript Review and Technology) is an integrated

set of programs designed to work together to support the submission of

peer-reviewed Brain Research manuscripts through the review cycle.

SMART uses the Internet as the connecting network among all users.

Authors use certified commercial software applications to author their

manuscripts. Information concerning the authors, paper format, journals,

keywords, and manuscript files are assembled together into a package by

SMART and transmitted through the Internet to a server. The review

phase is initiated and selected reviewers electronically read and write their

reviews. Advantages are greatly reduced time-to-review, time-to-publish,

and time-to-read periods.

SMART has four basic software applications.

SMART Submitter - Authors use this to assemble manuscripts and to

transmit them to the SMART server over the Internet. SMART Submitter

can also be used to check the status of the review cycle.

SMART Reviewer - Reviewers use this to retrieve manuscripts from the

SMART server and to enter comments, evaluations, scores, and

commentaries which are transmitted back to the SMART server.

SMART Staff - Editors and staff members of Brain Research use this to

log into the server and to retrieve new manuscript submissions, assign

reviewers, send notifications to reviewers, see reviewers' evaluations, and

to take final actions of manuscripts.

SMART Server - this interacts with all other SMART applications to
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receive, send, hold, and analyze all information flow.

SMART currently requires a Macintosh computer with at System 7.5.3

installed, a minimum of 8 MB RAM for 68K processors, or 16 MB of

RAM for PowerPC processors, and 8 MB of free disk space. An internet

connection is required for SMART to operate properly between the author's

or reviewer's machine and the SMART server.

SMART will be ported to Windows 95 and Windows NT by the middle of

1997.
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Before You Begin

This chapter deals with topics that you should be aware of before using

SMART for the first time.

• Package Contents

• Hardware and Software Requirements

• Installing the Software

• About this Manual

• How to use this Manual

• Technical Support
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Package Contents

If you received the SMART software package directly, it contains the

following:

• This manual

• Installation disks

• One SMART registration card

If you received SMART from the Internet electronically, you have one

installation file.  Refer to the section on Installing the Software to

continue.
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Hardware and Software Requirements

Macintosh

• A Macintosh Quadra or later, with a hard drive and 10 MB free

for complete installation.  A 68040 minimum processor is

recommended

• System 7.1 or later

• 32 MB minimum available RAM

Power Macintosh

• Hard drive and 15 MBytes free for complete installation

• System 7.1 or later

• 32 MB of available RAM
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Installing the Software

Installations disks - if you have installations disks, follow these instructions

to install SMART:

1.Turn on your Macintosh if it is not already on

2. Quit any applications that are active

3. Insert Installer Disk 1 into any floppy drive

4. Double-click Install Me to begin the installation process

5. Follow the prompts on your screen

6. Eject the Installer Disk 1 and store all disks in a safe place

Network download - If you have an installation file from the Internet,

follow these instructions to install SMART:

1. Turn on your Macintosh if it is not already on

2. Quit any applications that are active

3. Double-click Install Me to begin the installation process

4. Follow the prompts on your screen

The installation process creates a SMART folder containing all of the

folders and files of SMART, including the Reviewer application and creates

a Preferences folder in the System Folder: Preferences:SMART folder.

Several files are copied to the Extensions folder

AOS PowerPlug

AOS Runtime

GNU RegEx (fat)
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WASTE (fat)

Several files are also copied to the Extensions folder depending on the

Macintosh model:

ANSI C CFM68K Lib....................................................(For 68K machines)

ANSI C PPC Lib........................................................... (For PPC machines)

To Register Your Copy of the Software

Registering your copy of SMART is important.  By registering, you get

free Technical Support (see the section on Technical Support) and you

will be notified of all improvements and upgrades  to the software
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About this Manual

This manual provides both instructional and reference material to help you

get the most from using SMART.  The manual consists of:

• QuickStart

• The Basics

• The Database

• The Server

• Appendixes

QuickStart should be read if you installed the software, are familiar with

Macintosh applications, and want to begin using the application immediately

The Basics contains information on initial files created, user interface

issues, and network communications

The Database introduces you to the database document, what it contains,

and how to maintain it

The Server explains how to start and maintain the server

Appendices has all of the appendices mentioned in the other sections,

such as certified word processors, optimizing memory, networking issues,

commercial and software utilities that make using SMART software perform

better, and an expanded list of themes.
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Conventions used in this manual

Whenever special attention is required for a topic, the Alert graphic is

displayed.  Pay special attention to this information as it is important.

Whenever there is a good tip useful to remember, the Tip graphic is

displayed.

Whenever there is emphasis required on a certain point, the By The Way

graphic is displayed.
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How to use this Manual

This manual assumes that you are familiar with basic Macintosh operations,

such as pressing and dragging the mouse; selecting, copying, and moving

icons of files and folders; choosing commands from pull-down and pop-up

menus; pressing on buttons to activate commands, opening and closing

documents, launching applications, managing windows and their scrollbars,

title bars, close box, and zoom box; and using the Finder.  If you are not

familiar with these terms and operations, read your Macintosh User’s

Guide to learn more about your Macintosh.
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Technical Support

We have worked hard to make sure that the software and the manual are

easy to use.  Should you have any difficulty, please follow the instructions

below.

We support SMART users via EMail.  If you are having difficulties and

cannot find the answers in these manuals, please EMail us a note.

Before Calling for Help

1. Make sure that your computer is properly set up, and that all

cable connections are secure.

2. Make sure that you have properly installed the software according

to the installation instructions in these manuals.  All software

extensions installed have no known conflicts with other extensions.

3. Be sure that you have sufficient memory (RAM), especially if

you are running on a PowerMac.

4. Be sure that you are correctly configured to access the Internet

via TCP/IP.  Contact your Network Administrator if you suspect

a problem.

5. If you suspect a hardware problems or a problem with your

system software, contact your local Apple deal.
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EMailing for Help

SMART support is currently limited to EMail.  You will receive a prompt

answer via EMail.  Please include your Macintosh model name and number,

the version of SMART, and a brief description of the problem.

EMail to:

SMART@scripps.edu

Please put the word Tech Support in the subject heading.
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Chapter 1
Quickstart

Read this chapter if you are familiar with Macintosh applications and want

to use SMART right away.  This section assumes that you have already

installed SMART.

1. Double-click Server to launch the application.

2. Select Configure... from the File menu  to enter in the listening

port number, and the SMTP and POP server addresses.

3. Select New Database... from the File menu to open a new

database.

4. Select Start Server... from the File menu to start the server

listening for connections from clients.

5. Select Server Status...  from the Admin menu  to open a status

window.
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Chapter 2
The Basics

This chapter contains information on initial files created, user interface

issues, and network communications.

• Launching for the First Time

• User Interface

• Configuration
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Launching for the First Time

Double-click on Server to launch the application.  When Server launches

for the first time, a folder named SMART is created in your Preferences

folder (Figure 2.1).  In this folder is an additional folder named Client

Patches and a file named Client Preferences.   Client Patche holds software

patches supplied in the future.  Client Preferences contains the data on

user preferences.

Figure 2.1
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User Interface

The user interface experience is similar to other Macintosh programs.

Windows are used to convey most of the information to and from Server.

Some fields in windows may be multi-columned (Figure 2.2).  The width

of the columns can be adjusted by positioning the cursor on a vertical line

of a column.  The cursor changes to a column cursor.   While pressing the

mouse button down, drag the mouse from left to right to resize the column.

Any columns to the right of the vertical line being adjusted shift left and

right by the same amount.  To adjust only the immediately adjacent columns

of the vertical line, hold down the Control key when moving the mouse.

Column Cursor

Columns

Column Titles

Figure 2.2

Tip: Hold down the Control key when adjusting the column to adjust

only the current columns touching the vertical line.

Column Cursor
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Many windows are also sensitive to drag and drop.  If you select certain

data or lines of text, and then drag this to another window, or to the

Macintosh Finder desktop, data are copied, transferred, or exported.

Likewise, some windows may have files dragged into them.  See later

chapters for more specific information on the capabilities of each window.

Alert: Drag and Drop must be supported in those applications.

Figure 2.3 shows the text of the name being dragged from the administrator’s

window to the desktop, creating a text clipping file.
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Drag and drop with mouse

Figure 2.3

Many of the fields of windows also accept fully styled text.  To change the

text directly in a field, select Text Tool from the Edit Menu  to open the

Text Tool Window (Figure 2.4)

Figure 2.4

To change text:

1. Select the text to be changed using the mouse

2. Press on the various controls in the Text Tool Window to

alter the font, the style, the size, or the color
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Configuration

SMART must be configured with certain network information. Select

Configure... in the File menu to open a configuration window (Figure 2.5).

Figure 2.5

• The Port Number is the number of the listening TCP/IP port for

incoming requests from SMART clients.

• The POP Server  is the name or the IP address of the server for

Post Office Protocol (POP) mail.  Check with your Network

Administrator for this information.

• The SMTP Server is the name or the IP address of the server for

Simple Mail Transfer Protocol (SMTP) mail.  Check with your

Network Administrator for this information.

• The Server Email Return Address is the mail address for this

SMART server.  Check with your Network Administrator for this

information .
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You only need to configure this information once.  Reconfiguration is

required if one of the following conditions occur:

• The preference file is deleted or becomes corrupted

• You reinstall a new version of the operating system that may

create a new system Preference folder
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Chapter 3
The Database

This chapter will show you how to use Server to open and maintain a

database.

• About Databases

• Creating a New Database

• Opening an Existing Database

• Saving a Database

• Closing a Database

• Rebuilding a Database

• Adding an Administrator

• Importing TAB Delimited Data

• Exporting TAB Delimited Data
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About Databases

A database is a collection of files organized into a physical folder residing

on the hard disk drive.  Only one database may be opened at any one time

while the server is running.  The server  must be started before the database

can be accessed from the network.

The folders and files in a database hold information about the objects in

the database.  The files are also the place where persistent information is

stored, while RAM holds a subset of this information.

By The Way: The term OBJECT is used repeatedly throughout this manual

and refers primarily to a database record.  The database itself consists of

two primary tables - manuscripts and people.  Therefore, the two primary

kinds of objects are manuscript objects and people objects.

The files must remain synchronized with one another.  The server does

this automatically when it is running, and when clients connect and access

the information.  However, if the server experiences some unexpected

interruption, such as a crash of the computer or software, some files may

not be properly updated.  In this case, the database reports as being out of

sync, and requires a rebuild of the database to restore referential link

integrity.

A database contains unlimited amount of information, limited only by the
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size of its mounted disk volume.  The database can be created on any

volume, including Appleshare servers, optical media, floppies, and even

tape drives.  However, speed of file access is critical, and the fastest

random access device is recommended.

Databases are handled much like Macintosh documents.  New documents

are created, existing documents are opened or saved.
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Creating a New Database

Select New Database...  in the File Menu to create a new database for use

by the server.  This menu item is enabled only if the server is not running.

A database cannot be created until the server is stopped.  A file dialog

opens to store the database (Figure 3.1).

Figure 3.1

The default name supplied by the Server is Untitled.  Enter any name and

the press the Save button .  A new folder is created.  The database opens

and is ready to accept data.
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Opening an Existing Database

Select Open Database... in the File Menu to open an existing database on

a mounted disk volume.  A file dialog opens (Figure 3.2) to select the

database folder.  This menu item is enabled only if the server is not

running.  A database cannot be opened until the server is stopped.

Figure 3.2

Navigate through the mounted disk volumes and locate the database folder.

The files as displayed in Figure 3.2 should be located in this database

folder.  When you are in the correct database folder, press the button

labelled Select “SMART DB”.  Note that the name of your folder replaces

SMART DB.  This database then opens as the current database for this

server.
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Saving a Database

Select Save Database in the File Menu to save an opened database to the

disk volume.  This menu item is enabled only if the server is not running.

A database cannot be saved until the server is stopped.

Saving a database writes current information in memory to disk, and

synchronizes all data.  When a database has been saved, it may be closed

properly.  If a database is not saved, that database is not be properly

synchronized, and requires a Rebuild.

By The Way: The database is closed when the database is saved.  You

must use the Open Database.... command to open the database again.
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Closing a Database

Select Close Database in the File Menu to close an opened database to

the disk volume.  This menu item is enabled only if the server is not

running.  A database cannot be closed until the server is stopped, otherwise

an alert is displayed (Figure 3.3).

Figure 3.3

If a database has been modified but not yet saved, another alert is displayed

to save the database before closing it (Figure 3.4).  Closing the database

without saving requires a rebuild before that database can be reopened.

Figure 3.4

Closing a database removes information about itself from the server memory.

Another database can then be opened for use by the server.
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Rebuilding a Database

Use this function when a database has been interrupted unexpectedly, such

as the server crashing before the database has been saved.  Rebuilding a

database synchronizes certain information in database files with one another,

and ensures that the database can be opened properly without any loss of

information.

The integrity of the database is checked each time a database opens.  If

there is a problem, the server requires a rebuild (Figure 3.5).

Figure 3.5

The rebuilding process can also be manually started by selecting Rebuild

Database... in the File Menu.  This menu item is enabled only if the

server is not running.  A database cannot be rebuilt until the server is

stopped.  A file dialog opens to locate the database folder to rebuild

(Figure 3.6).
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Figure 3.6

Any existing database file is renamed to DB.bak  before the rebuilding

process begins (Figure 3.7).

Figure 3.7

During the rebuilding process, a progress window displays information.

The rebuilding process cannot be interrupted.   When the rebuild concludes,

a summary of the database is displayed (Figure 3.8).

Figure 3.8
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By The Way: The rebuild process does not exit with the database opened.

You must now use the Open Database.... command to open the database

for use.
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Adding an Administrator

A new database cannot be accessed remotely by any client program until

new users are added.  The server software adds only adminstrators to the

database as users.  The administrator logs into the database remotely and

continues adding new users of other privilege levels.

Select Add a new administrator... in the Admin Menu.  This

menu item is enabled only if a database is opened.  A window

opens to enter in information about this new administrator

(Figure 3.9).  The Login Name and Password fields must be

completed.  This is the login/password that this person uses to log

into SMART using client software.  The Last Name and the First

Name fields must also be completed.  Press on the Store button to

store this object into the database.

Required Information

Should be entered

Figure 3.9

The EMail address of the administrator is an important field to enter.  The

administrator receives automatic notification from the server when the
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server requires attention, such as low disk space.
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Importing TAB Delimited Data

Select Import objects from tab-delimited text... in the Admin Menu.

This menu item is enabled only if a database is opened.
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Exporting TAB Delimited Data

Select Export objects as tab-delimited text... in the Admin Menu.

This menu item is enabled only if a database is opened.

Chapter 4
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Chapter 4
The Server

This chapter will show you how to start the server on the network, and

maintain it once it is running.

• Starting the Server

• Server Status Window

• Disallowing New Connections

• Showing Users

• Mainitaining the Running Server
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Starting the Server

The server may be started only if a database is opened.  Starting a server

instructs it to listen to the configured TCP/IP port for requests from remote

network clients.  The database cannot be closed once the server starts.

The server continues to run until it is manually stopped.  All progress logs

and displays in a status window.

Select Start Server... in the File Menu to instruct the server to listen for

connection requests.  This menu item is enabled only if a database is

opened.  Certain initial parameters are checked before the server is started.

1. The basic configuration is checked and if any parameters are

missing, the server does not start.  See Chapter Basics, Section

Configuration for more information.

2. Form letters need to be present in the database folder.  These

letters are created automatically when a database is created.

However, if for some reason, the files are not located, the server

does not start.

3. If available RAM is low, the server does not start.  You should

quit other applications that may be running, or install more RAM

in the computer.

4. If available disk space is low, the server does not start.  You

should choose another mounted disk volume for the database, or

free up more disk space.

If the basic requirements are met, the server attempts to start itself over the

network.  A valid network is first confirmed.  This may fail if the Macintosh
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computer is not properly configured for a TCP/IP connection to a network

(Figure 4.1).  If so, check with your Network Administrator to be sure that

the Macintosh is properly configured for TCP/IP access.

Figure 4.1

The next two conditions that are checked are access to the SMTP and POP

servers.  If access to these servers is denied, warnings are displayed

(Figure 4.2).  The server starts, but services to and from these servers are

not available.

Figure 4.2

Finally, the server listens to incoming network requests on the port.  Any

error in initiating this process is displayed (Figure 4.3) and the server does

not start.
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Figure 4.3

If the server successfully starts, the status window (see next section) displays

this as a log entry.

First log entry 
when server starts 
on a new database

Figure 4.3
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Server Status Window

The status of the server is displayed by selecting Server Status  in the

Admin Menu.  The keyboard equivalent of Shift-Command-S can

also be selected from the keyboard.  This menu item is enabled only if

a database is opened.  (Figure 4.4).

General Information

Log of Activity

Figure 4.4

Certain information is displayed in this window.

• Date/Time - This is the current date and time on the server.

• Uptime - This is the total time in days, hours, minutes, and

seconds that the server has been on and available from the network.

• Disk Space - This is the total available amount of disk space

available on the disk volume holding the currently opened database.
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• Heap - This is the total available free RAM available in the

computer.  This heap space is used for new objects and for objects

recreated from the database files.  It is be some amount less than

the total heap space alloted to the server application.

• Database - This is the current database opened for access.

• IP Address - This is the current IP address of the server computer.

• Port - This is the current port configured for listening to incoming

requests from remote clients.

• #Logs - This is the current number of log entries for the currently

opened database.  All or some of them may be displayed in the

scrolling list below.

• Total Connections - This displays two numbers representing the

total and the perpetual number of users connected to the server.

The total number of users is the number connected to the server

from the last start time.  The perpetual number of users is the

number connected to the server since the server was installed on

this computer.

• Current Connections - This displays three numbers representing

the current number of users, the current number of threads in

service, and the current number of client-server threads.  The current

number of users is the number currently connected to the server.

The current number of threads is the number of connections from

clients plus any commands from clients that may be currently in

the process of being handled.  Each thread is a single process that

is responsible for a single transaction between the server and client.

The current number of client-server threads are the number of special
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processes that run as servers on the client side, and clients on the

server side.  These are used for special background processing of

commands.

• Report Threads - This displays the number of threads processing

report generations.  This number always decrement itself down to

0.

• Total Objects  - This is the total number of all first class objects

in the server and is the sum of the people and manuscript objects.

• Manuscripts - This is the total number of all manuscripts in the

server.

• People - This is the total number of all people in the server.

• Cached - This is the total number of all objects in the server that

have been brought into real memory, as opposed to being stored

persistently in the database on the mounted disk volume.

The field at the bottom of the window labelled Limit is the amount of logs

displayed at any one time.  The maximum amount that may be entered is

500.  The radio buttons labelled Most Recent at Top and Oldest at Top

affect the order of the display.

The scrolling field in the center of the window displays the actual log

entries.  These entries display certain information about activity on the

server.

• Date- This is the current date and time when the log was recorded.
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• Level - This indicates the level of priority of the log entry, and

can be a value of low, medium, or high.  A high priority is displayed

in MAGENTA color.

• Type - The type of the log is displayed here as a message, an

alert, or an error.  A message is informational, and needs no action

from you.  An alert is a message with more urgency.  You should

be aware of the alert, and action may be needed.  A error indicates

that some condition has occured that probably needs your attention.

It may be an error that occured with software, with disk or memory

conditions, or it may be one that is introduced by a client, such as

an incorrect password.  An error is displayed in RED color.

• Action - This is a description of the log.
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Disallowing New Connections

To prevent new remote clients from logging in over the network to the

server, select Disallow new connections from the Admin Menu

(Figure 4.5).  The menu item then displays a check mark before it, indicating

that new connections are disallowed.  This does not disrupt current users

or their work.

Select this to 
prevent new users 
from logging into 

the server

Figure 4.5

Select this feature if the server needs to be stopped.  New users cannot log

on.  When the last user logs off,  the server. can be safely stopped
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Showing Users

All connected users may be listed in a window (Figure 4.6).  Each person

has his ID, name and institute listed.  Only fully logged in users are

shown, not those using SMART Submitter or SMART Reviewer.

Figure 4.6

Selecting one or more of the users in the list enables the Send Message...

and the Disconnect buttons.  If you press the Disconnect Button, a

confirmation window displays (Figure 4.7).

Figure 4.7

If you press the Disconnect Button again, all selected users are forced off

the server.  A message displays on the users’s monitor (Figure 4.8).
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Figure 4.8

Use this when to shut down the server immediately without waiting for

current users to log off.  This is also useful if a connected client shows no

activity, perhaps because of a dead connection.

If you press Send Message..., a window appears to enter in a message

(Figure 4.9).

Figure 4.9

If you press OK, the message is sent to all selected users immediately and

appears in a popup message window on their computer (Figure 4.10).  Their

work is not interrupted.

Figure 4.10
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Maintaining the Running Server

Once the server is running, there are some administrative options that help

maintain the server in a good state.  Occasionally, processes, also known

as threads, may not terminate properly and enter into an orphaned-like

state where they do nothing but take up memory and system resources.  A

thread may not terminate properly because of a poor network connection

that does not initiate a termination sequence properly, and because certain

state information in the thread on the server makes it appear to be a good

connection.  In these infrequent cases, you have to clean up the server

manually.

Listing All Threads - To list all threads that are currently running on the

server, select List all threads... from the Admin Menu.

Figure 4.10

An alert  indicates if there are no threads (i.e., no connected users and no

orphaned threads) (Figure 4.11).
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Figure 4.11

Existing threads are listed in another window (Figure 4.12).

Figure 4.12

Check for Orphaned Threads - Orphaned threads are automatically

removed from the server.  However, there are rare conditions preventing

the server from removing them.  If you suspect this to be the case by

viewing the list of all threads and knowing what each user is doing, you

can initiate a cleanup of the orphaned threads manuallly.

Select Check for orphaned threads in the Admin Menu (Figure 4.13).
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Figure 4.13

This starts the cleanup process.  After attempting to remove orphaned

threads, a window reports any threads that remain (Figure 4.14).  This

number should be zero.  If it is not, and repeated attempts to remove it fail,

the server should be shut down and restarted.

Figure 4.14

Check for Low Memory - Select Check for low memory in the Admin

Menu (Figure 4.15).

Figure 4.15
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This checks for the availability of sufficient RAM to continue server

operations.  An alert indicates if there is sufficient memory to continue

(Figure 4.16).

Figure 4.16

If there is insufficient memory (Figure 4.17), service is be turned off.  A

log entry is made and an EMail note mailed automatically to the administrator

of this server.  New users cannot log in.

Figure 4.17

Check for Low Disk Space - Select Check for low disk space in the

Admin Menu (Figure 4.18).
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Figure 4.18

This checks for the availability of sufficient disk space to continue server

operations.  An alert indicates if there is sufficient disk space to continue

(Figure 4.19).

Figure 4.19

If there is insufficient disk space (Figure 4.20), service is be turned off.  A

log entry is made and an EMail note mailed automatically to the administrator

of this server.  New users cannot log in.

Figure 4.20

Check All Object Age - Select Check all object age  in the Admin Menu
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(Figure 4.21).

Figure 4.21

(Does nothing right now)

Enabling Object Flush - Select Enable object flush in the Admin Menu

(Figure 4.22).  The menu item displays a check mark before it, indicating

that objects can be flushed.

Figure 4.22

(Does nothing right now)
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Appendix A - Certified Software Applications

SMART is not an authoring program.  This means that the Author creates

the content of the manuscript with other programs, and use SMART to

bind them together into a manuscript object that is then transmitted over

the Internet to the SMART system.  Since the Reviewers and Editors of

SMART require that they be able to open and view your files, certified

software applications are below.  The Author should make every effort to

use one of more of these applications when authoring the manuscript.  If

this is not possible, the Author should comment heavily on the name and

version of the program, the computer, and the version of the operating

system in the Comments field of each file, or put this information in the

Comments section of the manuscript object.

Word Processors: (Macintosh)

• Microsoft Word 3.0, 4.0, 5.0, 6.0

• WordPerfect 3.0

• PageMaker 5.0

• NisusWriter 4.0

Spreadsheets: (Macintosh)

• Excel 5.0

•

Graphics: (Macintosh)

• MacDraw II

• Canvas

• Photoshop
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• Illustrator

• Freehand
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Appendix B - Optimizing Memory

The documents are RAM based.  Virtual memory, either Apple’s virtual

memory or  Connectix’s RAM Doubler, can be used with this application.

However, neither is recommended.  Apple’s virtual memory mechanism is

very inefficient.  RAM Doubler works better but it too can cause noticeable

delays when physical free RAM is low.  Be sure that 32 bit addressing is

on for the older Macintoshes, and that the Modern Memory Manager for

PowerPCs is on.

To turn off virtual memory  (Figure B1):

1. Choose Control Panels from the Apple menu, then double-click

Memory.

2. Press on the Off button to turn off virtual memory.

3. Choose Restart from the Special menu.

Figure B1
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You should read the Appendix on Optimizing Memory to set the memory

parameters for this application to the proper levels.
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Appendix C - Networking Issues

This application uses the Internet and the TCP/IP protocol to communicate

with the SMART server.  The Macintosh computer must be capable of

accessing the Internet, and must be able to run TCP/IP.  On the Macintosh,

TCP/IP is provided by using either MacTCP or Open Transport.

• The minimum version of MacTCP is 2.0.6

• The minimum version of Open Transport is 1.1

Apple’s AppleTalk Remote Access (ARA) can also be used with either of

the two IP enabling programs above to provide network access, but the

transmission speeds are limited to the speed of the phone modem used to

make the ARA connection.

IP Address and Port number must be configured.  See the chapter on

The Basics to see how to do this.  The addresses and port number are:

Current IP Address of SMART Server (as of Jan 1, 1997):

• 192.26.252.151

Current Port Number of SMART Server (as of Jan 1, 1997):

• 7000
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Appendix D - Useful Commercial Software

Connectix’s Speed Doubler should be used on every PowerMacintosh

because it replaces Apple’s Motorol 680x0 emulator with a much better

one.  This application was written in QKS SmalltalkAgents, and only

portions of it are in native PowerPC code.  With Speed Doubler, throughput

probably increases (as well as in many other commercial software

applications) by at least two-fold.
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Appendix E - Themes

The abbreviated list of themes is from the Society for NeuroSciences

themes.

THEME A: DEVELOPMENT AND REGENERATION
Developmental genetics
Genesis of neurons and glia
Cell lineage and determination
Cell differentiation and migration
Pattern formation, compartments, and boundaries
Process outgrowth, growth cones, and sprouting
Axon guidance mechanisms and pathways
Formation and specificity of synapses
Neurotransmitter systems and channels
Neurotrophic factors: expression and regulation
Neurotrophic factors: biological effects
Neurotrophic factors: receptors and cellular mechanisms
Hormones and development
Nutritional and prenatal factors
Neuronal death
Glia and other non-neuronal cells
Motor systems
Sensory systems
Cerebral cortex and limbic system
Visual system
Regeneration
Transplantation
Aging process

THEME B: CELLULAR AND MOLECULAR BIOLOGY
Staining, tracing, and imaging techniques
Neuroglia and myelin
Membrane composition and cell-surface macromolecules
Cytoskeleton transport and membrane targeting
Blood-brain barrier
Gene structure and function: general

THEME C: EXCITABLE MEMBRANES AND SYNAPTIC TRANSMISSION
Presynaptic mechanisms
Mechanisms of neurotransmitter release
Postsynaptic mechanisms
Long-term potentiation: physiology
Long-term potentiation: pharmacology
Ligand-gated ion channels
Sodium channels
Calcium channel structure, function, and expression
Calcium channel physiology, pharmacology, and modulation
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Potassium channel structure, function, and expression
Potassium channel physiology, pharmacology, and modulation
Other ion channels

THEME D: NEUROTRANSMITTERS, MODULATORS, TRANSPORTERS,
AND RECEPTORS

Acetylcholine
Acetylcholine receptors: muscarinic
Acetylcholine receptors: nicotinic
Excitatory amino acids: excitotoxicity
Excitatory amino acids: anatomy and physiology
Excitatory amino acids: pharmacology
Excitatory amino acid receptors: structure, function and expression
Excitatory amino acid receptors: physiology, pharmacology and modulation
GABA receptors
GABA
Peptide receptor structure and function
Peptides: biosynthesis, metabolism, and biochemical characterization
Peptides: anatomy and physiology
Opioid receptors
Opioids: anatomy, physiology, and behaviour
Catecholamine receptors
Catecholamines
Serotonin receptors
Serotonin
Other neurotransmitters
Transmitters in invertebrates
Interactions between neurotransmitters
Uptake and transporters
Regional localization of receptors and transmitters
Second messengers and phosphorylation
Signal transduction: gene expression
Behavioural pharmacology
Receptor modulation, up- and down-regulation

THEME E: ENDOCRINE AND AUTONOMIC REGULATION
Hypothalamic-pituitary-adrenal regulation
Hypothalamic-pituitary-gonadal regulation
Osmotic and thermal regulation
Neuroendocrine regulation: other
Neural-immune interactions
Cardiovascular regulation
Gastrointestinal and urogenital regulation
Respiratory regulation

THEME F: SENSORY SYSTEMS
Somatic and visceral afferents
Spinal cord
Subcortical somatosensory pathways
Somatosensory cortex and thalamocortical relationships
Pain: pathways
Pain modulation: anatomy and physiology
Pain modulation: pharmacology
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Retina and photoreceptors
Subcortical visual pathways
Visual cortex: striate
Visual cortex: extrastriate
Visual psychophysics and behaviour
Auditory, vestibular, and lateral line: periphery
Auditory systems: central physiology
Auditory systems: central anatomy
Olfactory senses
Gustatory senses
Invertebrate sensory systems

THEME G: MOTOR SYSTEMS AND SENSORIMOTOR INTEGRATION
Cortex
Basal ganglia
Thalamus
Cerebellum
Vestibular system
Oculomotor systems
Reflex function
Spinal cord and brainstem
Control of posture and movement
Circuitry and pattern generation
Invertebrate motor function
Muscle

THEME H: OTHER SYSTEMS OF THE CNS
Limbic system and hypothalamus
Association cortex and thalamocortical relations
Comparative neuroanatomy
Brain metabolism and blood flow

THEME I: NEURAL BASIS OF BEHAVIOUR
Cognition
Learning and memory;: systems and functions
Learning and memory: physiology
Learning and memory: pharmacology
Neural plasticity
Motivation and emotion
Biological rhythms and sleep
Neuroethology
Invertebrate learning and behaviour
Ingestive behaviours
Stress
Hormonal control of reproductive behaviour
Monoamines and behaviour
Neuropeptides and behaviour
Drugs of abuse: alcohol, barbiturates, and benzodiazepines
Drugs of abuse: amphetamine and other stimulants
Drugs of abuse: cocaine
Drugs of abuse: opioids and others
Psychopharmacological agents
Aging
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THEME J: DISORDERS OF THE NERVOUS SYSTEM
Genetic models
Developmental disorders
Epilepsy: human studies and animal models
Epilepsy: basic mechanisms
Epilepsy: anti-convulsant drugs
Degenerative disease: Alzheimer's - beta amyloid
Degenerative disease: Alzheimer's - cognitive function
Degenerative disease: Alzheimer's - neuropharmacology and
neurotransmitters
Degenerative disease: Alzheimer's - miscellaneous
Degenerative disease: Parkinson's
Degenerative disease: other
Ischemia
Trauma
Infectious diseases
Neuromuscular diseases
Neuropsychiatric disorders
Neurotoxicity
Neuro-oncology


